FlightCheck 6 Help Intro
Welcome to FlightCheck 6’s html based Help. If you have suggestions or find errors, please report them using our Tech Support
Request Form.
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Definitions->Intro
To help you better understand how to use FlightCheck this section contains definitions of key concepts and terms related to
FlightCheck.
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Definitions->Preflight Mode
Modes are actually files that control two main parts of the User experience with FlightCheck. First they control which language
text is displayed on screen, and second, they contain the Non_PDF and PDF preflight rule sets.
FlightCheck currently supports several languages including, English, Dutch, German, French and Spanish. Each language has two
modes, a Non_PDF Mode and a PDF Mode. By selecting a Preflight Mode from under the File menu, you can switch languages.
**Important Note #1 - FlightCheck 6 is set up to auto-switch between Non_PDF and PDF Preflight Modes based on the type of file
you preflight. If you manually switch Preflight Modes, you should first go the the Advanced Preferences area and deselect Auto
Preflight Detection, otherwise FlightCheck will continue to select a Preflight Mode based on the type of file you preflight.
**Important Note #2 - The very first time you start up FlightCheck you are asked to select a default language. If you select say US
(English) and then manually change Preflight Modes to say FR (French), unless you disable the Auto Preflight Detection preference,
FlightCheck will always switch back to the Default language you selected.
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Definitions->Auto Switch
Auto-switching is a feature of FlightCheck that “detects the type of file you are preflighting” and selects the proper Preflight
Mode.
To put this in plain English, if you preflight a Quark or InDesign file, FlightCheck will use the Non PDF Preflight Mode Rules. If you
preflight a PDF file, FlightCheck will automatically switch to the PDF Preflight Mode Rules. In earlier version of FlightCheck you had
to manually set up this feature. In FlightCheck 6, this feature is set up for you by default. **Note - In version 5 of FlightCheck,
Preflight Modes were referred to as FlightPlans.
The setup for auto-switching is found under the Advanced Preferences area.
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Definitions->Top Level Document
FlightCheck considers the document that was preflighted a Top Level document. Thus if you preflight an InDesign document that
uses 4 fonts and 10 images, FlightCheck will see the InDesign document as the Top Level document and not the linked images.
FlightCheck works on one Top Level document at a time. When you preflight several documents at once, each Overview Window
opened in FlightCheck is a report for a Top Level document. Thus, if you preflight three documents, you will see three Overview
Windows and one Results Window open in FlightCheck.
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Definitions->File Classes
Files Classes are another name for File Types. FlightCheck uses a sophisticated preflight engine that essentially classifies or
determines the type of file you are preflighting. If FlightCheck does not recognize the file you have preflighted, you can receive
feedback in a few different ways:
1) If the file is say a version of Quark or InDesign that FlightCheck does not recognize you will receive an Unreadable,
Unsupported or Locked message in the Results Windows if the Ground Control “Unreadable, Unsupported, or Locked” has been
set to the Warning or Error State.

2) If the Unreadable, Unsupported, or Locked” Ground Control has been set to a Warning or Error state you may also just see red
or blue text at the top of the Overview Window next to the Application area and, no entry in the Results Window.

If you encounter a file type that FlightCheck does not understand, and that file type and version are listed as supported in the
Version Support List found on Markzware’s website, then please send in a Tech Support Request and submit your unrecognized
file along with the request. Since there are so many ways of building files, including what image types are used, what fonts are
used and third party Plug-Ins or XTensions, in order for Markzware to see if we can figure out what the problem is, we need your
file.
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Definitions->Ground Controls
Ground Controls are preflight rules that are coded into FlightCheck. From the User perspective, Ground Controls consist mostly of
a series of checkboxes that can be configured into one of three states. There are some Ground Controls that require a value such
as the Resolution Ground Controls used in the example screenshots below. Ground Controls have three main states that affect
what you see in the Results and Overview windows:
The Off state - no dot is in the checkbox

No file Open

A File is open in FlightCheck

The Warning state - a small dot is in the checkbox and blue text or icons appear in the Results and Overview Windows.

No file Open

A File is open in FlightCheck

The Error state - a large dot is in the checkbox and red text or icons appear in the Results and Overview Windows.

No file Open

A File is open in FlightCheck
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Definitions->Results Window
The Results Window shows details about the document you have preflighted by using colored text. Every text entry in the Results
Window is the result of a Ground Control that has been set to a Warning or Error state and the condition the Ground Control
checks for has been detected in the preflighted document.
Following are three examples that show the same job with the the “Missing” image Ground Control set to Off, Warning and Error.
These examples also show how the Ground Control and Overview windows are affected by changing the state of the “Missing”
image Ground Control.

The Missing Image Ground Control is Off. Notice how the “Missing” Entry is not shown in the Results Window, this is because
turning Off a Ground Control removes the entry for that Ground Control from the Results Window.

The Missing Image Ground Control is set to Warning. The word “Missing” now shows in blue text in the Results Window.
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The Missing Image Ground Control is set to Error. The word “Missing” now shows in red text in the Results Window.
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Definitions->Overview Window
The Overview Window shows details about the document you have preflighted by using a combination of text, icons and hover
info.

Across the top of the Overview Window are buttons that hide or show each main category section. In FlightCheck Professional
there are eight buttons and in FlightCheck Designer there are three buttons for the Native Preflight Mode setting. (FlightCheck Pro
is pictured here)
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Definitions->Sub-Overview Window
A Sub-Overview Window is displayed when you double-click on an line entry in the Fonts, Color or Images areas of the Overview
Window. Doing this brings up a new window that only contains information about the item you just double-clicked on. This
feature is only available in FlightCheck Professional. Double-clicking on an item in FlightCheck Designer will not do anything.
Following is a sample screenshot showing a Sub-Overview window for an image with, File Info, Images and Picture tabs selected.
The name of the Sub-Overview window is the name of the item that was double-clicked on. In this example you are seeing just
information regarding the linked image Shirt06.tif.
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Definitions->Custom Views and Report Filters
Custom Views and Report Filters are related only to the Overview Window and pertain only to the Color, Fonts and Images areas.
Each of these areas has a popup menu that is built dynamically for each file that has been preflighted. The items listed in the
popup menus allow you to filter out items you may not be interested in. Selecting a filter in the popup menu changes what you
see on screen and also changes what gets saved or printed when you create a report with the Overview Window as the front most
Window.
Following are 4 screenshots showing how this works under the Color area:

Showing Used Colors is the default condition and filter when you preflight a document.

Clicking on the popup menu shows you all of the filters available for the currently open job. This list is built dynamically every
time you preflight a file and the contents depend on what was detected in the job.

Here, Spot Color has been selected as the filter. This spot color has not actually been used in the job, but is in the palette for the
job. If a spot color has been used in a job then the you should see a filter named Used Spot Color.

Here, colors are used in drop shadows in this InDesign CS2 document.
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Preferences->General
Under the General Preferences Area there are six items to setup:
Show Startup Messages - When enabled this will alert you of updates for FlightCheck or other news from Markzware.
Show Results - Enabled by default, this will bring up the Results Window every time a document is preflighted. Some people only
wish to see the Overview window, some people want to see both the Results and Overview windows. The Results window is a text
based summary of the issues detected in your document. The Overview window contains text as well as icons and hover info.
Play Alert Sound - When enabled, the famous (or infamous) Markzware eagle will squawk when a job has finished preflighting
and Errors have been detected in the job. This preference also enables the “zing” sound if a job preflight's without any errors. If
these sounds annoy you then deselect the Play Alert Sound checkbox. Many people like the sound on as they can work on other
tasks across the room and be notified by the squawk or zing when a job has finished preflighting.
Report Embedded Objects - When this Preference is enabled, FlightCheck will report on embedded objects in the Overview,
Results and Collect windows. If this Preference is disabled, FlightCheck will not report embedded objects (i.e., Fonts and Images )
as used. FlightCheck does not currently collect embedded objects.
Use Custom Icon For Collected Jobs - When this Preference is enabled, FlightCheck will add an icon to the Collected Job Folder.
If this preference is disabled or unchecked, FlightCheck will not add any icons to Collected Job Folders. By default this preference
is enabled.
Number of Recent Items: The number you put in this box reflects the number if items that will show up under the File->Open
Recent menu. It is advisable to not put large numbers in here, usually 5-10 items is a long enough list for most people to
manage.
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Preferences->Fonts->Setup
When FlightCheck builds its Font Database it looks into the following folders by Default:
Your HardDrive:System:Library:Fonts
Your HardDrive:Library:Fonts
Your HardDrive:Users:your home folder:Library:Fonts
In addition to the above paths you will see two more paths that are virtual paths. These paths are:
<Document Path> - This represents any folder at the same level as the document you preflight
<Active Fonts> - Since active fonts can reside in many different places, this is considered a virtual path.
Besides managing font paths you can also prioritize font paths by using the following methods:
Method 1 - Highlighting a font path and clicking on the up or down arrowheads on the right of the Font Paths window.
Method 2 - Highlighting a font path and clicking and dragging the name up or down in the list
In combination with the above you can also uncheck a font path so that FlightCheck will not search in that path. **Important Note
- Currently when you uncheck a Font Path, FlightCheck will not report on fonts in those paths, but FlightCheck will still scan
those paths.
Font paths at the top of the list have the highest priority and will be searched first.

There are three buttons that help you manage custom font paths that you enter. These buttons are:
New Absolute Path - This will allow you to navigate to a folder where you store fonts and select the folder, this is a hard-wired
path.
New Relative Path - This allows you to setup a flexible path that is relative to the document being preflighted.

20

If you have a workflow setup where you ask your customers, clients or Designers to always package a job in a certain folder
structure, then relative font paths can save you a lot of guesswork, headaches and time, because you just need to setup
FlightCheck once for your particular folder structure.
Remove Path - This removes a pathname from the Path window and from FlightCheck's search path for Fonts. If you try and
remove one of the initial paths that FlightCheck sets up, you will receive an error message.

You can delete custom paths that you add into the list.

There are two more Prefs on the Fonts Preferences Page
Allow Cross Platform Fonts - Enable this to allow FlightCheck to try and handle fonts from another platform. For example if you
have fonts from a Windows machine and you are preflighting on a Macintosh. This preference does not guarantee that
FlightCheck will be able to handle the cross platform fonts, it merely enables some behind the scenes checking that does its best
to handle these fonts.
Fonts Restricted to Mac OS Classic - If for some reason you are still running applications under Classic mode for OS9 and have
fonts loaded for Classic, activating this preference will restrict where FlightCheck looks for fonts to the official fonts area for the
Mac Classic environment.
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Preferences->Fonts->Fonts in Document Path
If you are dealing with a packaged or collected job and want to know if the person sent all of the fonts that are required for the
job, you can uncheck all but the <Document Path>. When you do this, FlightCheck looks in the same folder as the file you are
preflighting and if it finds a folder it will look inside of it for fonts. So regardless of whether you call the font folder Fonts, or
MyFonts or JobFonts, FlightCheck will tell you if the fonts are present.
Another cool thing about this feature is that the fonts in the <Document Path> do not need to be Active for FlightCheck to report
about them or Collect them. As long as FlightCheck knows where the fonts are, it can deal with them.

If you use this method, please make sure that you go to the Fonts Ground Control area and Uncheck the “Inactive Fonts” and
“Inactive Used Fonts” Ground Controls. Otherwise all of the fonts found in the <Document Path> will be flagged as Inactive and
Inactive Used Fonts. The exception to this would be if you activate fonts "in place" and you have activated the fonts in the
<Document Path> folder using a 3rd party font management tool.
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Preferences->Fonts->Active Fonts
To only deal with <Active Fonts>, uncheck all of the boxes except <Active Fonts>. By doing this FlightCheck will only flag a font
as missing if it is inactive.
Important Note - Even though the other Paths are unchecked, when you preflight a job, FlightCheck currently still scans through
the unchecked paths for System:Library:Fonts, Library:Fonts and Users:yourfolder:Library:Fonts.
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Preferences->Fonts->3rd Party Font Management Software
If you are using 3rd party font management tools, there are two main methods you can use in FlightCheck:
Method 1 - You can use the Active System Fonts method, where you uncheck all but <Active Fonts> in FlightCheck's Font
Preference area.
Method 2 - You can set up one or more Absolute paths to areas where your 3rd party font software stores its fonts.
Another interesting tidbit is that if you create an absolute font path to a folder where your 3rd party font software stores fonts, or
an absolute path to any other folder, FlightCheck can still report and collect these fonts even if you do not activate them.
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Preferences->Images
Calculate Image Previews - This is enabled by default and in FlightCheck Professional allows you to see a small thumbnail
preview of an image in the Sub-Overview window, if an image has an available preview. Not all images have previews available.
Calculate Image Densities - By default this is disabled as it tends to slow FlightCheck down. Enable this if you want to use the
Ink Density Ground Control located under the Images Ground Control section. Ink Density currently only works on TIFF and JPEG
file formats, it does not calculate ink densities for EPS files.

Image Paths
By default FlightCheck sets up four paths it will look in for images. Just like fonts, this is a prioritized list with the highest priority
path at the top of the list and the lowest priority at the bottom of the list. The four default paths are Relative paths, which means
they are relative to the document being preflighted. The paths are:
./ - This represents images found at the same level as the document that has been preflighted. This is useful if someone
packages or collects a job and throws all of the images loose in a folder along with the layout application document.
Images - This is the default name of the folder that FlightCheck collects images into. This is useful if someone has collected a
job using FlightCheck Pro or FlightCheck Designer.
Links - This is the default name of the folder that InDesign collects images into. This is useful if someone has collected a job
using InDesign and you want to make sure that all images are present.
Pictures - This is the default name of the folder that Quark collects images into. This is useful if someone has collected a job
using Quark and you want to make sure that all images are present.
There are three buttons to help you set up and manage image paths in FlightCheck.
New Absolute Path - This will allow you to navigate to a folder where you store images and select the folder, this is a hardwired path.
New Relative Path - This allows you to setup a flexible path that is relative to the document being preflighted. This is handy if
you want to know if someone who sent you a job included all of the images. You could for example add a new Relative Path
called “:MyPictures” and FlightCheck would check this folder at the same folder level as the document you are preflighting. If any
images are found in this folder, FlightCheck will report on these images.
If you have a workflow setup where you ask your customers, clients or Designers to always package a job in a certain folder
structure, then relative image paths can save you a lot of guesswork, headaches and time.
Delete Path - This removes a pathname from the Path window and from FlightCheck's search path for images.
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Preferences->OPI
In order to change the following three preferences, you must close all open documents in FlightCheck. Once you do this, these
Preferences will be available to modify.
Collect Low Resolution OPI Files - When this is enabled, FlightCheck will collect the low resolution or FPO OPI image. If this is
disabled (unchecked), FlightCheck will not collect the low resolution OPI images.
Collect High Resolution OPI Files - When this is enabled, FlightCheck will collect the high resolution OPI image. If this is
disabled (unchecked), FlightCheck will not collect the high resolution OPI images.
Report Using High Resolution OPI Files - When this is enabled (checked), FlightCheck will report using the data it finds for the
high resolution OPI image. This is what most people want as the low resolution OPI images are not used to process the final
postscript or PDF file sent to a RIP.
**Important Note - Flightcheck currently supports ColorCentral and has limited support for Helios. Xinet OPI is currently not
supported.

Format of File Path Embedded in Low Res Files - Depending on your OPI Software, the path written into the low resolution OPI
image may be one of the following platforms or standards. By Default, Best-effort Guess is checked. The four choices listed
below are represented as a set of radio buttons which means that only one choice can be active at a time.
Windows - Uses Windows path names typically denoted as C:\Some_directory
Macintosh - Uses Macintosh path names typically denoted as MyHD:Some Directory
Posix - Uses Posix path names typically denoted as /usr/local/
Best-effort Guess - FlightCheck looks at the path it finds and makes a decision whether to use Windows, Macintosh or Posix.

List of Absolute Search Paths
Adding a Path - Make sure that all open documents are closed. If you have any open documents, the + and - buttons will be
grayed out. To add a path for FlightCheck to search, click on the + button. This will bring up a normal system Choose a Folder
window where you can navigate to the folder you want to add to the path.
Making the Path Recursive - Once you have entered a path, on the left side of the path name is a checkbox called Recursive.
Check this box if you want FlightCheck to search down through all sub-levels of this folder. Making a folder recursive can cause
long scan times if the folder contains a lot of nested folders.

Search all Mounted Network Volumes - If this is enabled, FlightCheck will automatically search all network mounted volumes
when you preflight a file. This can cause very long scan times and is turned off by default. It is safer to add an absolute path to
your image repositories than to let FlightCheck search every volume you have mounted.
Search Recursively all Mounted Network Volumes - This will search all mounted network volumes recursively. This one can
really slow you down if your network volumes have many nested folders. This is also off by default and should be used with
caution.
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Preferences->Print
The Print Preferences allow you to control the appearance of reports printed out of FlightCheck. Although not perfect, these
preferences give you more control than the previous version of FlightCheck.

The Presets area is a drop down menu with five selections:
User Defined - Make manual adjustment of the print parameters to create a setting that fits your needs.
Small (Portrait) - Designed to print on portrait oriented paper and has very small type and icons.
Small (Landscape) - Designed to print a report with small text and icons in landscape mode.
Medium (Landscape) - Designed to print a report with medium text and icons in landscape mode. This is the most readable
report.
Large (Landscape) - Designed to print a report with large text and icons in landscape mode. The text and icons begin to overlap
in this setting.
Page Setup... Button - The Page Setup button allows you to quickly change the orientation of your printed page with out having
to exit and go to the File->Page Setup menu.
**Important Note - FlightCheck will not automatically set the Page Orientation for print output to Landscape if you select
a Landscape style, or Portrait if you select Portrait. You must change the page orientation manually.
Manual Adjustments
The manual adjustments area allows you to tweak settings to best fit your needs. The following are available for adjustment:
Font Size - This is a manual entry field and you must type in the size of the font you want to use. Usually 10-14 is a good
range. The size represents the Point size of the font before the report scaling and Page Orientation have been applied.
Font Name - This is a popup menu that allows you to select from active fonts on your System.
Output Resolution - This is like a scaling factor applied to the paper width and the larger the value the larger items appear on
the page. This works in relation with the Icon Width parameter.
Icon Width - This controls the size of the icons (mainly used when printing the Overview Window report). Large icon sizes are
unreadable and icons will overlap each other. Setting this higher than 120% usually creates icons that overlap each other.
**Tip - If you find that your print is too small, try changing your page orientation.
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Preferences->Advanced

Auto Preflight Mode Detection - When this is enabled, FlightCheck will look for entries in the File Type List to know when to
switch from the Non_PDF to the PDF PreFlight Modes. By default this is already set up for you when FlightCheck is installed. Now
when you preflight a Quark or InDesign file and then preflight a PDF file you will notice that the Ground Controls change and also
there is no Collect button for PDF files.
The Customize Button - Clicking on the Customize button brings up the File Type List window where the script entries for Auto
Preflight Mode Detection are stored.
Reduced Detail - Currently not active
Extended Features - Enabling this shows an extra checkbox on the Results window. This checkbox allows you to select "Show All
Items" instead of viewing just the Errors and Warnings. Enabling this Preference will confuse the average user of FlightCheck as
the list of items in the Results window will now show for almost every Ground Control available in FlightCheck. Unless you have a
need to see all of the intricate details of your document in a text based format, it is suggested that you leave this Preference
disabled and use the Overview Window to view details of your document.

Logging - By default this is disabled. If enabled, FlightCheck will create a log file in the same folder as the FlightCheck
application resides. This log file contains the name of files that have been preflighted, the time when they were opened, i.e.,
when they were preflighted and the time when they were closed. This may be useful for tracking how long certain files took to be
preflighted and possibly worked on.
Truncate Long Column Strings in Reports - This preference deals with how the report for the Overview Window looks if you
perform a Save As from under the File Menu. If this Preference is enabled, long files names will be chopped short or truncated. If
this is left unchecked then long filenames will not be truncated when present in the Overview Window Save As Report feature.
Instead, long filenames will be shown in full, this will result in a more rough appearing report.
This is how a report looks with Chop Long Column Strings in Reports enabled ↓
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This is how a report looks with Chop Long Column Strings in Reports disabled↓
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Main Menu->FlightCheck Menu
About FlightCheck - Clicking on this brings up the FlightCheck splash screen. The following information is listed on this screen:
1
2
3
4

Your serial number
The currently active Preflight Mode and its version number and language
The version of FlightCheck
The MarkzOne Engine version

Preferences - This brings up FlightCheck's Preference window. This window is also available by typing Command - Comma or by
clicking on the Preferences button in the FlightStrip
Services - This brings up the standard Macintosh Services menu. The contents of this menu vary depending on what you loaded
and how you have set up your Macintosh computer.
Hide FlightCheck - This will hide the FlightCheck application and all of its open windows.
Hide Others - This will hide open windows in applications other than FlightCheck. In order to re-enable the Hide FlightCheck
and Hide Others menu items after doing a Hide Others, you need to perform a Show All.
Show All - This re-enables the Hide FlightCheck and Hide Others menu items
Quit FlightCheck - This will close and exit the FlightCheck application.
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Main Menu->File Menu

Open - This will open a file for and begin preflighting it. You can also do a Command - O
Open Recent - This will bring up a list of recently preflighted files. The number of items in this list is controlled under the
General Preferences area. Usually somewhere between 3 and 10 files is the standard number of recent files people are
comfortable seeing.
Add File - This item is only available if you have a file open in FlightCheck. Selecing Add FIle brings up a standard Open File
dialog where you can select additional files to open in FlightCheck without closing the currently open file. **Important
Note/Limitation - If you have a Non-PDF file open and you use the Add File feature to select a PDF to preflight, you will not get
the results you are expecting. FlightCheck can only have one Preflight Mode active at a time, either Non_PDF or PDF. Which ever is
open first when an Add File operation is performed is the one that is used for ALL files added until you either quit FlightCheck or
perform another Open command. This can be a real gotcha, so rule of thumb is do not mix PDF and Non-PDF files in the same
sesion. First preflight one file type, finish up and then perform an Open on the other file type. The Open operation will close out
the previous file.
Load Preflight Mode - This allows you to manually select and load a Preflight Mode file. Instead of using this you should use
Preflight Mode and make a selection from the fly-out menu.
Preflight Mode - This will bring up a fly-out menu where you can select a different Preflight Mode. The main use for this is to
manually switch languages. All different languages that FlightCheck finds on startup are listed. If you need to manually switch
Preflight Modes, disable the "Auto Preflight Detection" Preference located under Advanced Preferences, otherwise FlightCheck will
always switch back to the default language you selected during the installation of FlightCheck.
Close - Closes the Results or Ground Controls windows if they are the front most window. If the Overview Window is the front
most window, then the current job is closed and you must re-open the job to see new Results and Overview Windows.
Save - Not available and is grayed out
Save As - If the Results Window is the front most window, this will save a FlightCheck Results report in text format. If the
Overview Window is the front most window this will save a text based version of the Overview Window report. This does not work
for the Ground Controls window.
Revert - Not available and is grayed out
Page Setup - Brings up a standard system Page Setup window where you can configure your printed page format. It is important
to setup your page orientation as this affects the Print Preferences area. **Important Note - FlightCheck does not automatically
switch the Page Orientation for you when you select Portrait or Landscape under the Print Preferences area, you must perform
that task manually in this area.
Print Results - This will appear in the menu if the Results Window is the front most window and will bring up a standard Page
Setup window where you can configure your page setup.
Print Report ... - This will appear in the menu if the Overview Window is the front most window and will first bring up the Print
Overview window selection window where you can select which sections of the Overview report you want included. Once you hit
OK, you will be presented with the Standard Page Setup window.
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Print Ground Controls...- This will appear in the menu if the Ground Controls window is the front most window and bring up a
standard Page Setup window where you can configure your page setup. The format of the Ground Controls printout is text based
and not graphical like FlightCheck's UI.
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Main Menu->Edit Menu

Can't Undo - Not available
Cut - Only available for text areas in the Ground Controls window, like resolution and flatness and for the text that displays
hints at the bottom of the Results Window if an item is highlighted.
Copy - Only available for text that has been copied in the Ground Controls window, like resolution and flatness and for the text
that displays hints at the bottom of the Results Window if an item is highlighted and for text input in the Collect Window.
Paste - Only available for text areas in the Ground Controls window, like resolution and flatness and for the text that displays
hints at the bottom of the Results Window. If an item is highlighted for text input in the Collect Window, this text can be pasted
into other apps besides FlightCheck.
**Important Note about Copy and Paste, you can copy text from other areas such as an image name in the Overview Window,
but when you paste it, you will not get the text that you expect as the text has been encoded and you typically see some
hexadecimal number representation.
Clear - This will clear the highlighted text and can be used wherever Copy and Paste can be used.
Select All - Not available and is grayed out.
Set Password - Here you can enter a password for the FlightCheck application. By entering a password, you will be required to
type it in every time you startup FlightCheck in order to access the application and be able to preflight documents. Unless you
have a compelling reason to password protect FlightCheck, please leave this alone. If you ever enter a password and forget the
password, the only way to recover is to delete FlightCheck's preferences and fonts database by starting up FlightCheck and
immediately holding down the Shift-Key. When you do this you will have lost all of your previous settings including any Ground
Controls sets you have created that you have not been exported.
Measurements - This allows you to select the units of measurement that you want FlightCheck to display for jobs you preflight.
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Main Menu->Preflight Menu

Preflight Document - This will recheck any open documents. If you have multiple documents open, they will all be rescanned if
you select Preflight Document. You can also use Command -F to invoke this command. This is the same as hitting the Recheck
button in the FlightStrip.
Display FlightCheck®Results - This will bring up the Results Window if you have hidden it, or it will bring the Results Window to
the font if you have several windows open. You can also use Command - M to invoke this command.
Show Ground Controls - This will bring up the Ground Controls Window if you have hidden it, or it will bring the Ground
Controls Window to the front if you have several windows open. You can also use Command - G to invoke this command.
Launch Document - This will attempt to launch the native application for the current document you have open. If you have
multiple documents open, FlightCheck will attempt to launch the native application for the document listed in the front most
Overview Window. **A few words of caution here - FlightCheck cannot launch applications that you do not have access to on
your computer. Also, currently FlightCheck will launch the latest version of the application it finds. For example if you preflight a
Quark 6 document and have both Quark 6 and 7 loaded on your computer, FlightCheck will attempt to launch the document in
Quark 7.
Find Image - This menu item will be available if you have any images flagged as missing. This allows you to select a single
image and then navigate to where you believe the missing image is located. When using Find Image, you can actually point
FlightCheck to a different image than the one originally used in the job. Using Show Image Folder does not allow you to do this.
Show Image Folder... - This menu item will be available if you have any images flagged as missing. This allows you to select a
folder where you believe the missing images reside. Once you select a folder, FlightCheck will rescan the job and look in the
folder you selected for the images flagged as missing. If FlightCheck finds the images, it will report additional information about
the images. If FlightCheck cannot find the images, they will still be flagged as missing. This is a great tool to see if someone has
sent you all of the images required for a job. If they package the job with all of its images into a folder called MyImages, you can
point FlightCheck to that folder to make sure they didn't forget any images.
**Note about Show Image and Show Image Folder - neither one of these functions actually links or re-links images to your
job. They are used to allow FlightCheck to find images so that image attributes such as RGB or CMYK color space or resolution
can be reported.
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Main Menu->Views Menu
This menu is visible under both FlightCheck Professional and FlightCheck Designer but, only contains a menu item under
FlightCheck Professional. Clicking on Views under FlightCheck Designer does nothing but highlight the word Views. Under
FlightCheck Professional the menu contains a single entry:

Show Page Layout - The Page Layout Window presents a wireframe view of pages on the left side of the window and a list of
items on the right side of the window. Selecting an item on the right side of the window highlights the item in the left hand
portion of the window. This is useful for finding objects such as RGB images. At the bottom of the Page Layout Window is an area
where you are presented with more information about the highlighted item. Page Layout is only available when you have a
document open in FlightCheck.
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Main Menu->Collect Menu

Collect Job... - This item is available when you have a job open in FlightCheck. Selecting Collect Job or performing a Command - J
will bring up the Collect Window where you can collect and package your preflighted job for submission to a printer or other
party, or for archival purposes.
Collect Report... - This will create a Collection Report for the job listed in the front most Overview window. If you only have one
document open, then the report will be for that document. The Collect Report is an inventory of what FlightCheck can collect for
a job and what is flagged as missing. This is the same report that is created by default when you collect a job. This menu item
gives you the option of just saving the report without actually collecting the job.
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Main Menu->Windows Menu

Hide FlightStrip - This will hide the FlightStrip. The FlightStrip is the gray bar that contains one-click easy access buttons such
as Open (preflight a document) or Collect. If you hide the FlightStrip, this menu item changes to Show FlightStrip. This acts as a
toggle-switch.
Hide FlightStrip Titles - This will hide the text names for the one-click buttons in the FlightStrip. If you hide the FlightStrip
Titles, this menu item changes to Show FlightStrip Titles.
Font Database - This is new to FlightCheck 6 and this will bring up FlightCheck's Font Database Window where you can see
which fonts are Active, which fonts are in the documents local path and which fonts are in paths that you have custom defined.
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Main Menu->Help Menu

FlightCheck Help - This will bring up the built in help for FlightCheck in your default web browser. You are reading the help file
right now ;-) If for some reason you have moved the Help folder from within your FlightCheck folder, when you try and access
Help you will be taken to a Help area on Markzware's website (http://www.markzware.com/flightcheck/help/). You can also use
Command -Shift-? to invoke Help from anywhere in FlightCheck.
Markzware Home Page - This will fire up your default web browser and take you to Markzware's website. Here you can view the
latest info from Markzware as well as fill out a Tech Support Request.
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Collect Window->Collect Destination
The Collection Destination area is located at the top of the Collect Window.
This area is where you select a destination or path where FlightCheck will save your collected job too.
Clicking on the "Choose" button will bring up a standard Save dialog where you can select the destination for FlightCheck to save
your collected job. By default FlightCheck will save collected jobs to your desktop. Once you select a destination, FlightCheck will
continue to use this as the default destination to collect future jobs unless you change the destination again.

43

Collect Window->Destination Info
In the Destination Info area you can select from the following options:
Compress Job - Checking this box enables ZIP compression for the job being collected
Create Job Folder - If this box is enabled (which it is by default), FlightCheck will create a folder that has the name shown in the
Folder/Archive area.
If the job you have collected has no errors in it, FlightCheck will add a black FlightCheck Eagle to the ZIP or collected Folder icon.
**Important Note - The job can still get a black FlightCheck Eagle if it contains Warnings.

If the job you have collected has errors in it, FlightCheck will add a black FlightCheck Eagle and a red X to the ZIP or collected
Folder icon.

Folder/Archive - This area shows the name of the job to be collected. If you have compression selected the name by default will
be "your job name_f.zip". If you have compression turned off by default the collected job will be named "your job name_f". You
can also enter your own custom name in here are well.
The Space Available line shows the space available on your hard drive. If the space available number is larger than the Total Job
Size (uncompressed) number then you are most likely not going to encounter hard drive space issues. If you receive an error
because you do not have enough free disk space to collect a job the fastest way to save your collected job is to select another
destination like an external hard drive or a network mounted volume and then collect and save your job to that destination.
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Collect Window->Job Info
The Job Info area displays information about the the job being collected.
The Total File Count lists the total number of files that FlightCheck will collect. This number can be changed by turning on or off
the checkboxes in the Collectable File Classes window or the Files window. The Collect All Files in Class, Collect Used Files in
Class and Collect None Of The Files In Class buttons also can affect the Total File Count as well.
Total Job Size (uncompressed) lists the size of the collected job. This is the size the job will be when decompressed. Selecting
Compress Job will not affect this value.

45

Collect Window->Collectable File Classes
The Collectable File Classes area has two main sections:
The Collectable File Classes Window located on the left portion of this window area and the four buttons located on the right side
of this area.
The Collectable File Classes Window located on the left lists the main classes (or types) of files that will be collected and the file
count for each type of file. Types of files that can be collected include:
Document - This is typically the InDesign, Quark or layout application file
Image - This includes the images linked to the Document class such as TIFF and EPS files
Suitcases - These are the bitmap portion of postscript fonts, also known as screen fonts
Type 1 Font Files - These are the postscript portion of postscript fonts also known as printer fonts
Fonts - these are OpenType fonts, TrueType fonts and dFonts
Low Resolution OPI Images - These are low resolution OPI images used as place holders
High Resolution OPI Images - These are full resolution OPI images and are used in output to a platesetter or imagesetter
Collect Report - By default FlightCheck creates an inventory report, called a Collect Report. This is a text based report. If you do
not want this report to be added to the collected job package, uncheck the Collect Report File Class.
The four buttons: In order to activate the buttons you must select an item in the Collectable File Class window on the left side of
the window. Once you select an item it should highlight with a blue bar and white text. At this point you can select any of the
four buttons to apply to the highlighted Class. Only one File Class can be highlighted and worked on at a time.

File Class Options - Clicking on this button brings up the "Collect Class Options" window. This window is where you can:
1) Create or change the names of Subfolders for collected items such as Fonts and Images.
2) Omit referenced but unused files - This checkbox is on by default and tells FlightCheck to not collect referenced but unused
items. This is designed mostly for Fonts where fonts that are part of an unused Style Sheet would collect if this item was
unchecked. Omit referenced but unused is actually the same as the "Collect Used Files In Class" button.
**Important Note - If you change the names of the folders for Fonts to be collected into, you must have a job with all of the
different types of Fonts present, otherwise your Postscript fonts and OpenType fonts may wind up in two different subfolders, as
each Collectable File Class can have its own subfolder.

Collect All Files In Class - Highlighting a Class and clicking on the "Collect All Files In Class" button will cause FlightCheck to
collect everything associated with a job. This button mostly affects the collection of Fonts. If you have an unused font in your job,
FlightCheck will display it in italics in the Files area of the Collect window. These files are not collected by default. If you select
"Collect All Files In Class", these fonts will now be collected. This is usually not what people want.
Collect Used Files In Class - Highlighting a Class and clicking on the "Collect Used Files In Class" button will cause FlightCheck
to collect only files that are used in the job. This button mostly affects the collection of Fonts. If you have an unused font in your
job, FlightCheck will display it in italics in the Files area of the Collect window. These files are not collected by default. If you
select "Collect Used Files In Class", these fonts will still not be collected. This is the default state of FlightCheck and is what most
people want. You do not have to set this up as FlightCheck out of the box is setup to collect only "Used Files in Class" for all
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Classes.
Collect None Of The Files In Class - Highlighting a Class and clicking on the "Collect None Of The Files In Class" button will
cause FlightCheck to collect nothing for that particular Class. This button is rarely used. An example of where this button might
be useful is if you have a job that you are sending to someone and you do not want to send along your images, instead of
deselecting each image individually in the Files window, you can simply highlight the Image Class and click on "Collect None Of
The Files In Class". Once you do this all Images will be deselected in the Files window in one click.
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Collect Window->Files
The Files area lists the files that FlightCheck detected as associated with the job to be collected. On the left hand side of the
window is column named Collect that contains a checkbox for most items. If the box is checked for an item, then FlightCheck will
attempt to collect the item.
If an item is missing, by default there is a check in the box next to it, but FlightCheck will not be able to collect that item as it
cannot be found.
On the right side of the Files window is a column named Size. This column will list the size in bytes of each item being collected.
**Please note that embedded Fonts and Images show <embedded> in the Size column and do not have a checkbox in the Collect
column. FlightCheck does not allow for the collection of embedded fonts or images.
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Ground Controls->Non_PDF->File->Application
Application - This Ground Control will trigger if you have scanned a document created with an application that is not present on
your system.
Unreadable, Unsupported, or Locked - This is a catch all Ground Control basically it triggers if the document you are scanning
is a file format that FlightCheck does not understand, or the document is locked because it is in use by another application.
**Note - This error is most commonly seen when a supported file format is scanned but the file contains some data that
FlightCheck cannot understand. FlightCheck aborts the preflight gracefully by displaying this message. If you see this message,
you should fill out our Tech Support Request Form and send us the file. If you do not send us the file, we have no hope of
discovering what FlightCheck cannot understand in the document.
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Ground Controls->Non_PDF->File->Document
Version - FlightCheck scans through your system and looks to see what applications you have present, like which version of
Quark or InDesign you have. This Ground Control triggers if the document that you are scanning was created with a version
different than the latest version that FlightCheck detected. **In today's world, many of us have several versions of DTP apps
loaded on our computers to deal with older file types. Thus, this Ground Control is off by default.
Language - This Ground Control will trigger if the document was created in a language that is different than the language the
application is set for. For example, you receive a document created in a French version of InDesign and you are running InDesign
on an English system. When you scan the document created on the French version, on your system, this Ground Control should
trigger. **This does not work with OS X multi-language capabilities if you switch your Operating System Language.
Supporting Files - This Ground Control triggers if the document you are opening requires an XTension or Plugin in order to be
opened or printed. This is useful if for instance you are receiving incorrect output at print time, but everything looks OK, a certain
plugin or XT that formats the print stream for output may be missing (whether printing to file or directly to a printer).
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Ground Controls->Non_PDF->Colors->Usage
Non-CMYK/Pantone® - This GC will trigger if a color is detected that is either non-CMYK (like RGB or LaB) or the color is not a
Pantone color. Pantone colors regardless of whether they are Spot of Process display a model of PAN in the Overview Window
under the Model column.
Unused Spot Colors - This GC will trigger if a spot color is in the jobs color palette, but is not detected as being used in any
objects such as, shapes, fonts, images etc., in the document.
Uses Spot Color - This GC will trigger if a spot color is in the jobs color palette, and is detected as being used in any objects
such as, shapes, fonts, images etc., in the document. This is a flag that the actual print job will contain additional plates, usually
more that 4 (CMYK).
Unnamed Colors - This GC will trigger if FlightCheck has detected unnamed colors in the job. Unnamed colors are created by
mixing a color and then applying the color directly to an object such as a shape or text, without adding the color to your color
palette. Several software packages have a feature that allows you to name unnamed colors.
Non-Default Trap - This is a Quark centric Ground Control. Quark allows users to define non-default trapping for a specific
color. This is found under the Edit->Colors... menu by selecting a color and clicking on the Edit Trap button. If the user has
modified the default trap value for a specific color this GC will trigger. Even if the color is not used in the document, but resides
in the color palette, this Ground Control will trigger, but the color will not show as used. When this Ground Control is triggered,
an icon will appear in the non-automatic
default trapping column in the Colors area. **Insert picture of icon here and refer to Icon Legend PDF entry M on the Colors page
Bitmap Frames - Certain programs (mainly Quark and PageMaker) allow the user to apply built in frame styles to boxes. These
frames are bitmap frames and depending on your print workflow and RIP configuration may print very pixilated. This GC triggers
if a bitmap frame has been applied to a box or shape.
Mismatched Colors - This GC will trigger if an EPSF file contains a color whose color values (CMYK component values) do not
match a color of the same name already in the documents color palette. This is an issue when spot colors with the same names
are used in document and in imported EPSF files, but each application defines the CMYK components of those spot colors with
different values. This becomes important for spot colors as you may get two plates from a RIP for what you thought was a single
spot color. For Process colors, this may cause items you were expecting to be the same color to be different colors on the final
printed piece.
Mismatched Spot/Process - This GC will trigger when an imported or placed EPSF file uses a color that is also in the
applications color palette and the two colors do not match type, i.e., one is a process and one is a spot color. For example, you
may have an EPSF file with Pantone 185 red as a spot color and then place this EPSF into an InDesign document. In the InDesign
document you have Pantone 185 Red, but you have converted it to a process color. These two reds will actually be on different
plates upon output from the RIP, as the Pantone 185 Red as a spot will create a fifth plate, whereas the Pantone 185 Red
converted to process will be composed on CMYK inks. The two Reds will look different when printed and may have enough of a
difference in visual color to cause an issue with the job.
Similar name spot color - This GC will trigger if 2 spot colors have very similar names. This situation can occur when spot
colors are selected from different libraries. For example, PANTONE Rubine Red M and PANTONE Rubine Red U. One color is from
the Solid Uncoated PANTONE Library (U), and one is from the PANTONE Solid Matte library (M). Each color will typically produce a
separate printing plate, whereas you may want just a single plate for Rubine Red.
Blend/gradient - This GC will trigger if a color is detected as being used in a blend or gradient. Blends are a Quark based term
and Gradients are an Adobe based term, typically Illustrator and InDesign.
Patterns - Certain programs come with pre-defined fill patterns that can be applied to shapes. In certain workflows these
patterns may cause problems on final output. The two most common problems being 1) The pattern prints pixilated because it is
a bitmap pattern or 2) The pattern is a postscript pattern and can slow down the RIP and take a long time to process.
Hairlines - This GC allows you to set a threshold of how fine of a hairline you are willing to accept. For example, if you enter a
value of .25 points and turn on this GC, any hairline that is less than or equal too .25 points will trigger this GC. This means that
a hairline of .24 or .249 points will trigger this GC, a hairline of .25 point will trigger this GC, but a hairline of .251 or .26 points
will not trigger this GC. FlightCheck currently can check up to three digits to the right of the decimal place.
Transparencies - This GC will trigger if a transparency has been detected in an object used in the document. This GC will also
trigger if in InDesign you create a drop shadow that is not 100% opaque. Currently this only flags color filled boxes with
transparency, it does not detect text or images with transparency applied.
C+M+Y+K Too High - This GC will trigger if the sum of the CMYK values for a particular color exceed the value you specify.
Colors that have excessive amounts of ink in them can cause drying or even paper tearing problems when the job is being
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printed. ** On the Overview Windows the default filter is to show Used Colors, whereas in the Results Window there are no filters
applied. Thus you can see a discrepancy between the color names listed in the Overview and Results Windows.
C+M+Y+K Too Low - This GC will trigger if the sum of the CMYK values for a particular color are less than the value you
specify. Colors that have very little amounts of ink in them can literally disappear at print time if the plate cannot hold a very
small dot, or the plate becomes worn on the press over time. ** The same limitation listed for C+M+Y+K Too High also applies to
C+M+Y+K Too Low.
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Ground Controls->Non_PDF->Pages->Page Size
Width - This Ground Control will trigger if the documents page width is greater than the width of the printable area for a
specified device (like an imagesetter), This will cause clipping of part of your intended print area . This GC can only trigger if a
job has had a maximum printable width stored in its Printer's data record; this is usually accomplished by printing the document
to some device and then saving the document, as this width of the output is ascertained from the Printer Driver.
Height - This Ground Control will trigger if the documents page height is greater than the height of the printable area for a
specified device (like an imagesetter), This will cause clipping of part of your intended print area . This GC can only trigger if a
job has had a maximum printable height stored in its Printer's data record; this is usually accomplished by printing the document
to some device and then saving the document, as this height information is ascertained from the Printer Driver.
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Ground Controls->Non_PDF->Pages->Paper Size
Paper Width - This Ground Control will trigger if the documents page width does not match the printers paper width. Cases
where this can occur are when someone has flipped the orientation of a page and it is now wider than the paper width, which will
cause clipping.
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Ground Controls->Non_PDF->Trapping->Text
Overprint - This Ground Control will trigger if text trapping has been set to overprint in a QuarkXPress document. Black text is
set to overprint by default. An example of where overprinting text can be problematic is if you have white or paper colored text
and place it over an image and then set the text to overprint. This will cause the text to become less than 100% opaque, or
transparent when processed by a RIP and the text will either disappear or become very faint.
Knockout - This Ground Control will trigger if text trapping has been set to knockout in a QuarkXPress document. When text is
set to knockout, it acts like a cookie cutter and cuts out everything below it color-wise, so the actual paper color shows through.
If text is made up of more than one CMYK component value and is small, any misalignment during a press run will show as a
halo of color.
Auto - In Quark you can set a default value in the Preferences for Auto Amount. By default this value is 0.144 points. Whatever
the value you set, the Ground control will trigger if text trapping on Quark is set to either Auto Amount (+) or Auto Amount (-).
Custom - This Ground Control will trigger if text trapping has been set to Custom. In Quark by default this causes the text to
knockout.
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Ground Controls->Non_PDF->Trapping->Background
All Trapping settings under Background apply to the background color or fill of a text or image container. Text and Image
containers with a background fill of none are not allowed by Quark to have trapping settings.
Overprint - This Ground Control will trigger if the background color or fill of a text or image container is set to overprint. This
may cause problems if the container is over another object and the blending of colors may not be what the designer originally
intended.
Knockout - This Ground Control will trigger if the background color or fill of a text or image container is set to knockout. If the
container is on top of another item, the items color below the container will show through. This may pose a problem if the intent
was to see the paper show through in the knockout area.
Auto - In Quark you can set a default value in the Preferences for Auto Amount. By default this value is 0.144 points. Whatever
the value you set, the Ground control will trigger if a background color in a text or image container in Quark is set to either Auto
Amount (+) or Auto Amount (-).
Custom - This Ground Control will trigger if the background color in a text or image container has been set to Custom.
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Ground Controls->Non_PDF->Trapping->Frame/Line
All Trapping settings under Frame/Line deal with the color of a frame or a line. Frames can only be found on text or image
containers whereas lines exist as separate objects.
Overprint - This Ground Control will trigger if a frame or line color is set to overprint. Setting frames and lines to overprint may
cause them to blend into the background and disappear.
Knockout - This Ground Control will trigger if a frame or line color is set to knockout. Setting frames and lines to knockout may
allow the paper to show through in areas where you are expecting color to appear.
Auto - In Quark you can set a default value in the Preferences for Auto Amount. By default this value is 0.144 points. Whatever
the value you set, the Ground control will trigger if a color used in a frame or a line is set to either Auto Amount (+) or Auto
Amount (-).
Custom - This Ground Control will trigger if the color used in a frame or line has been set to Custom.
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Ground Controls->Non_PDF->Page Setup->Printer Type
These settings have to do with the type of Printer information stored in a document. This information is not actually stored in the
document until the document has been printed and saved.
Printer Type - This Ground Control will trigger if the PPD file defining the document's printer type cannot be located. The PPD
contains specific information related to the actual output device, such as a specific imagesetter or laser printer. Each device will
have different parameters.
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Ground Controls->Non_PDF->Page Setup->Output
These settings deal with output settings that affect the actual data of the file.
Output Resolution - This Ground Control will trigger if no output resolution can be determined in the document. Depending on
your workflow this can be good or bad.
Halftone Screen - This Ground Control will trigger if the halftone line screen value cannot be determined.
Use Printer's Screens - This Ground Control will trigger if a document has been set to use the line screen value obtained from a
specified printer (or PDF file AND NO this is not an Adobe Acrobat file,DEFINITION OF PDF in this case means PRINTER
DEFINITION FILE).
ASCII Data - This Ground Control will trigger if the output data has been set to ASCII. This is done in your print screen. Some
RIPs or output devices may not handle ASCII data properly, this all depends on your particular workflow.
Binary Data - This Ground Control will trigger if the output data has been set to Binary. This is done in your print screen. Some
RIPs or output devices may not handle Binary data properly, this all depends on your particular workflow.
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Ground Controls->Non_PDF->Page Setup->Options
These setting deal with options that some print drives contain that affect the output of the file.
Landscape - This Ground Control will trigger if the paper orientation has been set to Landscape. This can be a problem if the
Designer sets the paper orientation to Landscape and the Printer outputs in Portrait, as this may cause clipping of the image in
the final printed piece.
Portrait - This Ground Control will trigger if the paper orientation has been set to Portrait. This can be a problem if the Designer
sets the paper orientation to Portrait and the Printer outputs in Landscape, as this may cause clipping of the image in the final
printed piece.
Reduce - This Ground Control will trigger if a page has been set to print at a scaling factor less that 100%.
Enlarge - This Ground Control will trigger if a page has been set to print at a scaling factor of greater than 100%.
Options - This Ground Control will trigger if the user has selected additional Printer Options. ****This is very OS9'ish in
terminology. Printer dialog boxes have changed under OS X.
N Up - This Ground Control will trigger if the user has set the job to print with more than one page per piece of paper. Under
OS X this is now found under the Layout menu.
Cover Page Before - This Ground Control will trigger if the user has selected Print Cover Page Before a document. This is a
problem for Printers as in most workflows it causes wasted film and plates.
Cover Page After - This Ground Control will trigger if the user has selected Print Cover Page After a document. This is a
problem for Printers as in most workflows it causes wasted film and plates.
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Ground Controls->Non_PDF->Fonts->Status
Inactive Fonts - This Ground Control will trigger if any font referenced in the document is not active on your system. Please
note that a referenced font does not mean that the font is actually used in a document. The classic example of this is a font
referenced because it is part of a style sheet and that style sheet is not used in the document. Typically instead of this Ground
Control you will want to use the "Inactive Used Fonts" or "Missing Used Printer Fonts" or "Missing Used Printer Fonts".
Inactive Used Fonts - This Ground Control will trigger if a font actually used in a document is not active on your system. This
will only be a problem if you need to edit or print a document. If you are merely seeing if all fonts are present for a job, then
FlightCheck can still find and report on inactive fonts as long as you have set up your Font Database properly. Please see setting
up and using the fonts database.
Missing Screen Fonts - This Ground Control will trigger if FlightCheck cannot find a referenced Screen Font. Most people will
prefer to use "Missing Used Screen Fonts".
Missing Used Screen Fonts - This Ground Control will trigger if FlightCheck cannot find a Screen Font detected as being used in
document. Screen fonts are the bitmap portion of PostScript fonts and when missing may cause fonts to image improperly on
screen. This can be an issue if you use soft proofing.
Missing Printer Fonts - This Ground Control will trigger if FlightCheck cannot find a referenced Printer Font. Most people will
prefer to use "Missing Used Printer Fonts".
Missing Used Printer Fonts - This Ground Control will trigger if FlightCheck cannot find a Printer Font detected as being used
in document. Printer fonts are the vector portion of PostScript fonts and when missing cause fonts to image improperly on final
output to plate or film.
Embedded Fonts - This Ground Control will trigger if a font is detected as Embedded in a document. Embedded fonts may
cause issues if someone tries to do a last minute edit of a document and they do not have the actual font that is embedded
installed and active on their system. Embedded fonts may essentially prevent last minute editing of jobs. FlightCheck does not
collect embedded fonts, but it does flag them as embedded in the Collect Window. By default Adobe Illustrator embeds fonts into
EPS files. If you want to collect fonts used in EPS file then you may want to consider changing the setting in Illustrator to link to
fonts instead of embed them.
Corporate Fonts - This Ground Control will trigger if you added any font names to the Corporate Fonts list and the fonts are
detected in the document but are not on your list. Corporate Fonts can be quite useful if you require a specific set of fonts for
say a corporate identity and you want to be warned if someone uses a font that is not on your approved list of fonts.
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Ground Controls->Non_PDF->Fonts->Type
These Ground Controls deal with actual font types.
TrueType® - This Ground Control will trigger if a font is detected as a TrueType font. With the advent of OpenType, TrueType
fonts can now be wrapped in an OpenType wrapper. Flightcheck will report these OpenType fonts as TrueType.
City/System Fonts - City named fonts like Geneva and Chicago will trigger this Ground Control. This is a holdover from the OS9
days when fonts with city names caused jaggy type to be imaged on many output devices.
Multiple Masters - Multiple Master fonts are fonts that can be morphed into other shapes. The most common Multiple Master
fonts are the ones shipped with Adobe Acrobat which are used to display non-embedded or subsetted fonts that are missing in
the PDF file. From a preflight perspective Multiple Master fonts used to cause many output problems from the RIP. Depending on
your workflow, Multiple Master fonts may be good or bad, you will need to communicate with your printer as to whether these
type of fonts cause issues through their workflow.
Non-Adobe® - There are many great type foundries out there. In the days of yesteryear, fonts that were not from Adobe used
to cause issues with many RIPs. In todays world this is not as common.
OpenType® - OpenType fonts are designed to be cross platform (Mac and Win). OpenType fonts are different than older font
tecnologies in that they have the ability to contain up to 65,000 glyphs within a single font. These additional characters could be
alternate swash characters or different languages. The newer RIPs should be able to handle OpenType fonts. From a Printer's
perspective OpenType fonts are good in that they are a single font file unike Postscript fonts that have a bitmap portion of the
font (Screen Font) and a printer portion of the font (Printer Font).
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Ground Controls->Non_PDF->Fonts->Usage
Menu Styled - This Ground Control will trigger if the user applied a style to a font without selecting the actual font name from
the font selection menu. This can cause problems if the user applies a style of say Bold to a font and actually does not have the
Bold version of that font loaded on their computer. QuarkXPress and PageMaker allowed this "menu styling" to occur. InDesign
does not allow this feature.
Encoding - This Ground Control will trigger when a font uses a non-standard encoding. The non-standard encoding affects how
output devices may image a font.
Unused Fonts - Should be Unused fonts in Style Sheet. This Ground Control will trigger if an unused style sheet is referencing a
font that is not currently active. This will not affect print output, but may be a condition that some people may want to be
warned is present.
Small point sizes - This Ground Control will trigger if text below the specified size is detected as used in the document. This
can be important if someone uses say 4 point type and in your workflow type this small tends to break up and become
unreadable.
Text Shadow - This Ground Control will trigger if a text container has a drop shadow applied to it. InDesign and Quark currently
only allow drop shadows applied to the entire text container.
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Ground Controls->Non_PDF->Print->Output
These Ground Controls are Quark Centric and deal with detecting a Print Setting under Options->Pictures->Output.
Normal
Low
Rough
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Ground Controls->Non_PDF->Print->Separation
On - This Ground Control will trigger if the user has selected Separations to be on when printing the document. With separations
on, a CMYK document will print 4 pages, one for each color. Most Printers do not like separations on as they handle the
separation into CMYK plus any spot colors in their normal workflow.
Off - This Ground Control will trigger if the user has selected Separations to be off when printing the document. This is typically
what you want. Most people leave this Ground Control Off by default as they only want to be warned if separations are turned on.
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Ground Controls->Non_PDF->Print->Spreads
Yes - This Ground Control will trigger if Spreads are set to on when the document is printed. This can cause jobs to be cutoff on
the actual film or plate output.
No - This Ground Control will trigger if Spreads are set to off when the document is printed. This is typically what you want, but
most people leave this Ground Control Off by default as they only want to be warned if spreads have been turned on.
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Ground Controls->Non_PDF->Print->Registration
These have to deal with Registration Marks applied through a Printer Setup Window
Off - This Ground Control will trigger if Registration Marks are set to off. In many workflows people want to add their own
registration marks, this means that in FlightCheck you will want to have this Ground Control turned off unless you need to detect
this condition.
Centered - This Ground Control will trigger if the user has turned on Registration Marks. In QuarkXPress the user can select
Centered Registration Marks, whereas in InDesign, merely clicking the Registration Marks checkbox in the Marks and Bleeds
screen sets the Registration Marks to Centered. Many Printers like to add their own marks and prefer not to receive print jobs with
Registration Marks turned on. By default this Ground Control is On to catch any registration marks created by applications such
as InDesign and Quark.
Off Center - This Ground Control relates only to QuarkXPress where the user can select Off Center Registration marks. InDesign
does not have this selection by default. Many Printers like to add their own marks and prefer not to receive print jobs with
Registration Marks turned on. By default this Ground Control is On to catch any registration marks created by Quark.
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Ground Controls->Non_PDF->Print->Bleed
Insufficient Bleed - This Ground Control will trigger if the user has set a bleed value and objects that extend outside of the
page boundary do not extend at least the value specified as the bleed value. For example, if you set a bleed value of .125" and
you have a picture box that extends off the page, if the box does not extend at least .126" beyond the page boundary, this
Ground Control will trigger. (the value entered is a greater than value, not a greater than or equal to value)
Bleed - This Ground Control merely detects that a Bleed value was set in the DTP application (like Quark or InDesign). This
Ground Control does not deal with actual Bleed values, only its presence.
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Ground Controls->Non_PDF->Print->Sequence
These are set up in the Print screen and affect which pages get out printed.
All - Usually you can leave this Ground Control off, as you want all pages to image. If this Ground Control is on, then you will be
warned if all pages are set to print, which is not the case for most workflows.
Odd - This Ground Control will trigger if only the odd numbered pages have been set to print.
Even - This Ground Control will trigger if only the even numbered pages have been set to print.

69

Ground Controls->Non_PDF->Print->Tiling
Tiling is a print output setting for page sizes that are larger than paper size. Tiling splits up the large document into pieces that
can print on the actual paper and be assembled later.
Off - For most print jobs, you want tiling off, thus it is not advisable to turn on this Ground Control unless your workflow
requires tiling.
Manual - Since most workflows do not want print settings set to tile, this Ground Control is on by default to warn you if
someone has set Manual Tiling. Tiling can cause more pages to be output than you are expecting, which can cause additional
plates or film to be output. Tiling may also cause clipping if jobs are larger than an expected page size.
Auto - This Ground Control is on by default to warn you if someone has set AutoTiling.***InDesign adds a fourth type of Tiling
that Quark does not have called Auto-Justified that FlightCheck flags as Auto.
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Ground Controls->Non_PDF->Print->Options
Thumbnails - This will warn you if someone has turned on Thumbnails. Thumbnails are usually used to do a rough proof a
document and are not desirable for the final print job.
Collate - Collate can change the order pages print out in. This may be undesirable in many workflows.
Back To Front - If a job is set to print Back To Front, the pages print in reverse order. This may cause issues with certain
workflows.
Include Blank Pages - If blank pages are set to print then this Ground Control will trigger. In some case this may cause useless
waste of plates or film.
Print Colors as Grays - If the user has set colors to print as gray, this Ground Control will trigger. Printing colors as grays can
cause issues when a job is processed for print as color images usually wind up only as grayscale and show up only on the black
plate.
Black & White - If the user has set the job to print as black and white, this Ground Control will trigger. Just like print as grays
everything winds up on the black plate.
Color - This is the normal output condition for color jobs and you usually want to leave this Ground Control turned off.
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Ground Controls->Non_PDF->Images ->Type
The Ground Controls listed below all flag for different types of images. When the Ground Control for a particular image type is set
to the Error or Warning state, FlightCheck will flag any images of that type detected in the preflighted document. Below is some
additional information about each image type.
Pict - Pict files were the standard for Mac computers up through OS9. Pict files are RGB and do not work in CMYK workflows.
TIFF - TIFF or Tagged Image File Format images can come in many flavors. TIFF is one of the more common high resolution
image formats in wide use in the print industry. Typically you leave this Ground Control set to Off.
EPS - Encapsulated Postscript that is pixel based. These are files usually created in Photoshop. This Ground Control is Off by
default as EPS files are commonly accepted in the print industry.
EPSF - Encapsulated Postscript that contains vector data. These are files usually created in Illustrator. This Ground Control is Off
by default as EPSF files are commonly accepted in the print industry.
JPEG - Joint Photographic Experts Group. JPEG files typically come from the internet or digital cameras and are usually low
resolution. JPEG files use a lossy compression scheme, so they tend to have artifacts in the images that may not be suitable for
high quality print work.
CT - Scitex Continuous Tone format. Was common in the 1990’s.
DCS - Desktop Color Separation files. This is also referred to as DCS1. In this version of DCS, there are typically five files, a
preview file and separate grayscale files for CMYK. This is a pre-separated file.
DCS2 - DCS2 is an enhancement of DCS1 and allows for all separated pieces to be contained within a single file.
PSB - This is a large format Photoshop file.
PSD - This is the standard native file format for Photoshop files.
GIF - Graphic Interchange Format that was designed for use on screen and not print. GIF files are limited to a maximum of 256
colors and are typically low resolution, so most people want to be warned if GIF files are present in a print job. GIF files use the
Indexed Color Mode.
PC - This detects whether an image was created on a Windows computer.
Other - The most common Other Image types are PNG (Portable Network Graphics) and PDF. Many applications today let you
place PDF files as an image and currently doing this will trigger this Ground Control. This is a catch-all for images that do not
have specific Ground Controls to detect their type.
OPI - If an image was created by using an OPI sampling program, this Ground Control is designed to detect this. Currently Color
Central is the only OPI image type detected by FlightCheck.
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Ground Controls->Non_PDF->Images->Mode
Bitmap - This will trigger if a true bitmap image has been detected during preflighting. True bitmap images are typically bitmap
TIFF images with resolutions over 1000 dpi. Many times people tint these bitmap TIFFs and use them for logos. Usually the use of
bitmap TIFFs is not an issue for most people.
Monotone - This Ground Control will trigger if a monotone image created in Photoshop has been detected. A monotone image
uses only one color to tint the image. In Photoshop you must first make and image grayscale before you can create a monotone
image. Many times people will use a spot color to tint a monotone image. Depending on your workflow, monotone images may or
may not be problematic. For typical 4-Color workflows the only time a monotone image would be an issue was if someone used
a spot color instead of a process color to tint the image.
Duotone - This Ground Control will trigger if a duotone image created in Photoshop has been detected. Duotone images use
two colors to tint an image.
Tritone - This Ground Control will trigger if a tritone image created in Photoshop has been detected. Tritone images use three
colors to tint an image.
Quadtone - This Ground Control will trigger if a quadtone image created in Photoshop has been detected. Quadtone images use
four colors to tint an image.
Grayscale - This Ground Control will trigger if a grayscale image has been detected. Grayscale images are essentially monotone
images that use Black as the tint color. Normally grayscale images do not pose a problem in people's workflows.
Indexed Color - This Ground Control will trigger if an image uses the Indexed color space. Indexed Color images are usually GIF
files and are usually intended to be viewed as part of a page on the internet. The Indexed Color space consists of a max of 256
colors, so the image typically does not transfer well to print.
RGB Color - This Ground Control will trigger if an image is in RGB mode. Some people prefer RGB images and then do their own
color conversion, some people prefer to receive images already converted to CMYK for print.
CMYK Color - This Ground Control will trigger if an image is in CMYK mode. Depending on your workflow, this may be what you
want.
Lab Color - This Ground Control will trigger if an image is in Lab mode. Lab has a much wider gamut that CMYK, but unless you
have color management in place, you may receive unexpected results if you convert between colorspaces.
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Ground Controls->Non_PDF->Images->File Status
These Ground Controls are designed to give you feedback on the state of images used in a document.
Missing - This Ground Control will trigger if an image used in a document cannot be located. Usually this results in the low
resolution preview image being imaged to plate or film instead of the the crisp clear high resolution image.
Modified - This Ground Control will trigger if the last modified date of an image does not match the date of the link data saved
within the document being scanned. A modified image may indicate that an image has been altered and may not match the
original intent of the job.
Stored - This Ground Control will trigger if an image has been stored or embedded within a document. InDesign, Illustrator and
PageMaker can embed images, whereas Quark only deals with linked images. EPS files can also have images embedded or stored
within them. Stored images can be difficult to extract from files and many people in their workflows do not want to deal with
embedded images, they only want linked images.
Nested - This Ground Control will trigger if an EPS file that has a placed image inside of it (i.e., the images is linked to the EPS
and not embedded in it).
ASCII Data - Will fire if an image has been ASCII encoded. Depending on your workflow, this may or may not be a problem.
Binary Data - Will fire if an image has been Binary encoded. Depending on your workflow, this may or may not be a problem.
LZW Encoding - LZW is a compression scheme. This Ground Control will trigger if an image has been compressed using the LZW
method. Some RIPs have problems handling LZW encoded images
JPEG Encoding - JPEG is a compression scheme. This Ground Control will trigger if an image has been compressed using the
JPEG method. Some RIPs have problems handling JPEG encoded images.
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Ground Controls->Non_PDF->Images->Image Box
Suppressed - Some applications allow you to suppress image printing. The image is visible on the page when you view it on a
computer, but the image will not print. This can cause images to disappear from film or plates.
Off the Page - Will trigger when an image is completely outside of the page boundaries. This means that an image will not be
seen at print time, but the image is present in the job on the pasteboard.
Clipping Path - This Ground Control is useful as a general flag as to whether an image has a Clipping Path associated with it.
This Ground Control works best if you are preflighting a series of EPS or TIFF files that have not been placed in a layout
document, to see which files have Clipping Paths.
The following Clipping Path types are really geared towards detecting the type of Clipping Path that a Layout program such as
InDesign or Quark will use when an image with a Clipping Path has been placed into a layout document.
Clipping Path Type 'Embedded Path' - This is the typical “Clipping Path” as assigned in Photoshop. If this Ground Control
triggers then the DTP app is using the Clipping Path created in Photoshop to mask part of the image.
Clipping Path Type 'Non-White Area' Clipping Path Type 'Alpha Channel' Clipping Path Type 'Picture Bounds' Colored Fill - Will trigger if an image container with an image placed in it has a background color of other than Black, White or
None set In Quark 6.5, or Paper, Black or None in InDesign
Bitmap Frame - Will trigger if a bitmap frame has been applied to a text or image container in QuarkXPress. Appears to not be
an issue in InDesign. Bitmap frames do not scale well and may print in a jagged looking manor.
Box Rotation - Will trigger if the actual picture container has been rotated. In both Quark and InDesign you can rotate the
bounding box, i.e. container separately from the contents, this Ground Control detects that the container has been rotated.
Box Skew - Will trigger if an image container has had a skewing value applied to it.
Box Shadow - Will trigger if a text or image box (or container) has a Drop Shadow applied to it. **Note - In both Quark 7 and
InDesign, for text boxes you can only apply drop shadows to the entire box and its contents at one time.
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Ground Controls->Non_PDF->Images->Contents
Image Scale - WIll trigger if an image has been scaled up or down in size.
Image Rotation - Will trigger if the image itself has been rotated, the container can also be rotated, but this Ground Control
deals strictly with the contents of an image container.
Image Skew - Will trigger if the image itself has had a skew value applied.
H/V Flip - Will trigger if an image has been Horizontally or Vertically flipped.
Styles/Contrast - Quark centric Ground Control that flags whether a Style or Contrast has been applied to an image (from the
Style Menu)
Picture Trap - Will trigger if an image container in Quark has been set to something other than Default in the Trap Information
Window. Typically this affects Grayscale images.
Halftone Screen - Will trigger if an image has screening values associated with it. These typically are specified angles for the
CMYK components of a color image and this info can alter the actual pixel data in an image.
Transfer Function - Will trigger when a Transfer Function has been applied to an image. Transfer Functions are applied in
Photoshop when saving as EPS, DCS1 and DCS2 file formats. Typically Transfer functions are used to compensate for dot gain on
press. Using a transfer function may interfere with a printers normal color management procedure and thus a possible reason for
wanting to detect its presence.
Channels - Will trigger if images have extra channels in them. These channels are created in Photoshop. If extra channels are
detected you will see a number after the color mode in the Images area of the Overview window. For example, CMYK1 means the
image is a CMYK image with one extra channel. RGB2 would mean that the image is RGB and has two extra channels. EPS files
created out of Illustrator with a transparent background also will trigger this Ground Control as the transparency is handled by an
Alpha Channel. Does not report extra channels in EPS files from Photoshop, but does report for TIFF and PSD files.
Patterns - Will trigger if a pattern fill has been applied to an object. This triggers only with Pattern fills from Freehand and not
trigger for files from Illustrator with Patterns. Pattern fills refer to postscript pattern fills and may cause RIP time to increase on a
job.
Layers - This will trigger for Top Level document created in Quark and InDesign as well as TIFF images created in Photoshop that
have layers. EPS file with layers currently do not trigger this Ground Control
ICC Profile - This will trigger if an image has an ICC profile associated with it. In FlightCheck Pro you can double-click on an
image and see the name of the ICC profile in the Image Detail WIndow. Images with ICC Profiles will have an "*" to the left of the
Mode entry in the Overview Window. ** Important Note - In FlightCheck Designer you cannot double-click on an image name to
bring up the Image Detail Window, this feature is only available in FlightCheck Pro.
%PS Color Mgmt. - This will trigger if an EPS was created and the Postscript Color Management checkbox was selected. The
Postscript Color Management remaps the EPS files color space to a specified output devices color space, which may produce
undesirable results when that EPS file is placed into another document like an InDesign or Quark document that has its own
Color Management settings.
Ink Density Too High - Will trigger if the sum of the CMYK ink values exceeds the amount specified for this Ground Control
(user defined input). In order for this Ground Control to work, the Calculate Ink Densities checkbox must be selected. This
checkbox is located FlightCheck's main Preferences window under the Images area. The following file formats are not supported
or recognized by this Ground Control, CMYK EPS raster images and Indexed CMYK in PDF files. A note of caution, turning on
Calculate Ink Densities in the Preferences may significantly slow down the scanning process of FlightCheck. FlightCheck calculates
ink densities by scanning each image one pixel at a time and if any one pixel exceeds the value specified for this Ground Control,
the image is flagged as having an Ink Density Too High. FlightCheck does not report where the offending pixel is, merely that at
least one pixel in an image exceeds the specified value. Note - This only works on true raster images in FlightCheck, mainly TIFF
images.
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Ground Controls->Non_PDF->Images->Resolution
Resolution - This Ground Control applies only to Color and Grayscale images. This Ground Control only Flags "Effective
Resolution". This means that if you have an image that is originally 300 dpi and you place the image at 200% scaling, the
Effective Resolution of the image is cut in half and will be 150 dpi. If you place the same 300 dpi image at 50% scaling, the
Effective Resolution doubles and will be 600 dpi. If a Color or Grayscale image's Effective Resolution is below the dpi value
specified in Min Res OR above the specified dpi value in Max Res, this Ground Control will trigger. For example if you set Min Res
to 266 and Max Res to 400 and an image has an Effective Resolution of 233 dpi, the image will be flagged as out of range, if the
image has an Effective Resolution of 300 dpi, the image will not be flagged and if the image is 405 dpi, the image will be
flagged.
Bitmap Resolution - This Ground Control works in the same way as the Resolution Ground Control with one exception, this
Ground Control only checks true Bitmap images. A true Bitmap image (sometimes called lineart) only has two colors, Black and
White. These images are usually scanned in at high resolution so that the image will print without jaggy edges. Many people use
Bitmap images as a sort of fake vector image, thus the higher pixel counts. If the resolution on a Bitmap Tiff for example is too
low, the final image will print with jaggy edges, that is why the default values for this Ground Control are Min of 1200 dpi and
Max of 2400.
Flatness - Flatness values deal with how vector curves are converted to raster images. Lower Flatness values cause RIPs to do
more computation for a given curve. For 300 dpi images, the standard values are Min 1 and Max 3. Flatness values have a range
of 0.2 - 100 in Photoshop. The Flatness value [essentially] tells the RIP how smooth to rasterize a vector path (usually a clipping
path). Values that are too low will increase the amount of work a RIP has to do to rasterize an image and values that are too high
will produce non-smooth curves. With the advances in RIP technology and fast computers with lots of RAM and huge hard drives,
this may no longer be as serious an issue as it was with earlier generation RIPs.
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